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. The Triticeae Toolbox is a centralized database for small
grains breeders (wheat, oat, barley)

« Combines accession information, phenotype trial data,
and genotype data from various sources

« Allow users to create custom datasets

« Provide summary and analytical tools
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Welcome to The Triticeae Toolbox (T3)

The Triticeae Toolbox (T3) is a repository for public wheat data generated by the Wheat Coordinated Agricultural Project (Wheat CAP). Funding is
provided by the National Institute for Food and Agriculture (NIFA) and the United States Department of Agriculture (USDA). The current project is
funded through NIFA's International Wheat Yield Partnership (IWYP) and part of the Agriculture and Food Research Initiative (AFRI). A Project
Description, T3 Team, and Collaborators are described here.

Explore T3

Start to navigate the line information, phenotype trials, genotype experiments and genetic maps available in T3.

How to Select Data

Learn how to use the selection tools found under the "Select" menu, how to download this data and how to analyze it using one of the tools in
the "Analyze" menu.

Submit Data

Find out how to upload data to T3 using the data submission templates.

Blake, V., Birkett, C.L., Matthews, D.E., Hane, D., Bradbury, P., Jannink, J. 2015. The Triticeae Toolbox: Combining Phenotype and Genotype Data to
Advance Small-Grains Breeding. The Plant Genome. doi: 10.3835/PlantGenome2014.12.0099.
The T3 software is open source and available under the GNU General Public License (LICENSE) and may be downloaded from GitHub.

To send guestions or
suggestions to the T3
curators, please click here.

The Triticeae Toolbox is
part of the Triticeae CAP
project, supported by
Agriculture and Food
Research Initiative
Competitive Grant no.
2011-68002-30025 from
the USDA National Institute
of Food and Agriculture.

Coovriaht & 2006 - 2010

USDA united States Department of Agriculture
sl Agricultural Research Service

UDSINIFA |

The Hordeum Toolbox was
developed for the Barley CAP

The Triticeae Toolbox was
expanded from THT for the
Triticeae CAP

Tools have been added
periodically to T3

. 2012. The Hordeum Toolbox: The Barley Coordinated Agricultural Project genotype and phenotype resource. Plant Gen. 5:81-91.
.al. 2016. The Triticeae Toolbox: Combining Phenotype and Genotype Data to Advance Small-Grains Breeding. Plant Gen. 9:1-10
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What is Breedbase?

Breedbase is a comprehensive breeding management and analysis software. It can be used to design field layouts, collect phenotypic information using tablets, support
the collection of genotyping samples in a field, store large amounts of high density genotypic information, and provide Genomic Selection related analyses and
predictions. Breedbase supports the BrAPI standard.

How can | use Breedbase?

Breedbase is a web application that only requires a browser. To get your instance, follow this guide to deploy via docker, or contact the Breedbase development team.

What crops are using Breedbase?

There are a number of instances running for diverse crops, including Cassava (https://cassavabase.org), sweet potato (https://sweetpotatobase.org), banana
(https://musabase.org), rice (https://ricebase.org), tomato and other Solanaceae (https://solgenomics.net/) and many others.

BREEDBASE is located at the Boyce Thompson Institute.

BOYCE
THOMPSON
INSTITUTE




A "comprehensive breeding management and analysis
software”

Database, analytical tools and website
Developed by Lukas Mueller’s lab at Boyce Thompson Institute

Currently used by multiple crops: cassava, sweet potato,
banana, rice, Solanaceae crops



. Design field layouts

» Store phenotype trial information

- Tightly integrated with Fieldbook / Pheno Apps
. Store genotype information
. Provides summary and analytical tools

» BrAPI compliant



« More developers
—- Core development team at BTl
- Already being used by multiple crops

« Unified database
- Sharing of ideas, database structures, tools...

o Unique Features
— Trial Design
- Seedlot Management
- Barcodes (seedlots, accessions, plots, etc)



« Wheat: Data from T3/Classic has been migrated
Needs some manual reorganization

. Oat: Trait ontology created
Starting to load Accessions

. Barley: Coming Soon



The New T3/Wheat

Main Production Site Sandbox / Test Site

& https://wheat.triticeaetoolbox.org & https://wheat-sandbox.triticeaetoolbox.org

84 X SANDBOX SITE - Data added to this site will be periodically cleared
/ ]
v Tgy///’ N .
B7N T3/Wheat Search Manage  Analyze Maps  About [eWll Login
AN {New) SANDBOX
Welcome to the New T3/Wheat
. ) . ' ) ) o Welcome to the New T3/Wheat Sandbox
T3 is a repository for public wheat data generated by the Wheat Coordinated Agricultural Project (Wheat CAP). Funding is provided by the
National Institute for Food and Agriculture (NIFA) and the United States Department of Agriculture (USDA). The current project is funded . ) . . B
through NIFA's International Wheat Yield Partnership (IWYP) and part of the Agriculture and Food Research Initiative (AFRI). This is the SANDBOX site for T3/Wheat. The Sandbox can be used to test the addition of new data to T3. Data added to this site will be

periodically cleared and reset to match the main T3/Wheat site. Once your data is ready, please go to the main T3/Wheat site to permanently
The New T3 is the next evolution of The Triticeae Toolbox (T3). We are in the process of transitioning submit your data.
all of T3's data and tools to this new system. We encourage you to leave feedback about feature
improvements, missing tools, and/or any ideas you may have to improve the site.

T3 is a repository for public wheat data generated by the Wheat Coordinated Agricultural Project (Wheat CAP). Funding is provided by the
National Institute for Food and Agriculture (NIFA) and the United States Department of Agriculture (USDA). The current project is funded
through NIFA's International Wheat Yield Partnership (IWYP) and part of the Agriculture and Food Research Initiative (AFRI).

News

The New T3 is the next evolution of The Triticeae Toolbox (T3). We are in the process of transitioning -
Explore T3 all of T3's data and tools to this new system. We encourage you to leave feedback about feature "X Leave Feedback
- Use the Search Wizard to explore the database using improvements, missing tools, and/or any ideas you may have to improve the site.
T3 Phenotype Data Loaded various types of metadata. Q Open Search Wizard
March 13, 2019 ) i i . 3 )
Information on data loaded from T3. Alternatively, you can search specifically for Accessions, Trials, Traits, Genoptyping

News
News Item Title

March 10, 2019

Explore T3
Search Accessions Search Trials Search Traits

Use the Search Wizard to explore the database using
T3 Phenotype Data Loaded various types of metadata. Q Open Search Wizard
March 13, 2019
Information on data loaded from T3. Alte.rnatlvely, you can search specifically for Accessions, Trials, Traits, Genoptyping
Projects, or Markers

Put news item content here.
It can contain any HTML.

Projects, or Markers

Search Genotyping Projects

Search Markers

News Item Title

March 10, 2019 News Item Title [ Search Trials ] [ Search Traits ]
Put news item content here. Submit Data March 10, 2019

It can contain any HTML. Contributing data to T3? Put news itgm content here. [ Search Genotyping Projects ]

Put news item content here. It can contain any HTML.

S —




o Live Demos

« Screenshots in presentation

« Presentation will be available:
- New T3/Wheat website



» Creating an Account

. The Search Wizard

. Searching Accessions

« Using Lists

. Irial Design Tool

» Uploading Phenotype Data
o Trial Summary Tool



& https://wheat.triticeaetoolbox.org/user/new
« An account is required to:

- add any data to the database

- view some types of data in the database (such as phenotype
trial results)

- use some of the tools (such as summarizing trials)

« To check if you already have an account:

- Go to: Search > People to see if your name is already
associated with an account



Creating an Account

»’f:;,:" mT3/Wheat Search  Manage  Analyze  Maps  About Q
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Welcome to the New T3/Wheat

Click the “Login” Button in the
top right of any page

T3 is a repository for public wheat data generated by the Wheat Coordinated Agricultural Project (Wheat CAP). Funding is provided by the
National Institute for Food and Agriculture (NIFA) and the United States Department of Agriculture (USDA). The current project is funded through
NIFA's International Wheat Yield Partnership (IWYP) and part of the Agriculture and Food Research Initiative (AFRI).

X Leave Feedback

The New T3 is the next evolution of The Triticeae Toolbox (T3). We are in the process of transitioning all
of T3's data and tools to this new system. We encourage you to leave feedback about feature
improvements, missing tools, and/or any ideas you may have to improve the site.

Click “Login”
Button

News Explore T3

Use the Search Wizard to explore the database using
various types of metadata. Q Open Search Wizard

Alternatively, you can search specifically for Accessions, Trials, Traits, Genoptyping
Projects, or Markers

T3 Phenotype Data Loaded
March 13, 2019

Information on data loaded from T3.

News Item Title

[ Search Accessions } [ Search Trials ]
March 10, 2019

[ Search Traits ]

Search Markers

Put news item content here.

[ Search Genotyping Projects ]
It can contain any HTML.

News ltem Title
March 10, 2019

Put news item content here.

It can contain any HTML.

Put news item content here.

It can contain any HTML.

Put news item content here.

It can contain any HTML.
Put news item content here.
It can contain any HTML.

News Item Title
March 10, 2019

Submit Data
Contributing data to T37

Manage your Phenotypic Data to create spreadsheets
for new uploads, add new data, and/or manage your
existing uploads.

& Manage Phenotypic Data

Or Upload Files for various other types of data.
P Upload Files

User Guides

New to T3?
© Read Documentation

View the Documentation to learn about available
features.

Blake, V., Birkett, C.L., Matthews, D.E., Hane, D., Bradbury, P, Jannink, J. 2015. The Triticeae Toolbox: Combining Phenotype and Genotype Data to
Advance Small-Grains Breeding. The Plant Genome. doi: 10.3835/PlantGenome2014.12.0099.

T3 is open source software and available under the MIT License and may be downloaded from GitHub.




Creating an Account

Click the “New User” link in the
login pop-up window




Creating an Account

Create New Account

Notice Fill out the new account

« Before creating a new account, please check if you already have an account using the directory

registration form.

« Alink will be emailed to you. Please click on it to activate the account.
« All fields are required.

First Name:
Last Name:
Organization:

Username:

Username must be at least 7 characters long.

Password:

Password must be at least 7 characters long and different from your
username.

Confirm Password:

Password must be at least 7 characters long and different from your
username.

Email Address:

An email will be sent to this address requiring you to confirm its receipt to

activate your account.
Reset Create Account




Creating an Account

You will receive an email (from noreply@graingenes.org - check your Junk/Spam
folder) with a link to confirm your email address.

You must open the confirmation link before you can login to your account.

<\: mT3/Wheat Search Manage  Analyze Maps  About Q

Confirmation successful for username testing.

[Login Page]


mailto:noreply@graingenes.org

& https://wheat.triticeaetoolbox.org/breeders/search

« The Search Wizard can be used to:

- Explore the database
- Filter data by 1 or more search criteria
- Download filtered and/or combined datasets

« YOU must have an account to download data
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The Search Wizard
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Filter by Trials & Traits:

1) Select ‘Trials’
2) Choose (+) Trials to include

3) Select Traits’
4) Choose (+) Traits to include

5) Optionally continue to select
specific Accessions...



The Search Wizard
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The Search Wizard
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Example Phenotype Spreadsheet

phenotype.csv - LibreOffice Calc

Format

ReR X%h - 58 6 - Qe @ -@ - WU F RHESs Q -
0 b iU - CEE=ES@8 T+ LE - %0E WO == @A -
f« £ - = [97X0850-16

observationUnitName

replicate blockNumber plotNumber Grain test weight g/I|CO_321:0001210 Grain yield kg/ha|CO_321:0001218 notes

:’97X0850»16 JARS-NRPN-2005-AMES_97X0850-16_15064 2 1 15064 732.72 5218.6
6 BC97-ROM50W ARS-NRPN-2005-AMES_BC97-ROM50W_15062 2 1 15062 719.175 5171.525
7 CAMELOT ARS-NRPN-2005-AMES_CAMELOT_15022 2 1 15022 762.39 5393.45
8 HARDING ARS-NRPN-2005-AMES_HARDING_15004 2 1 15004 772.065 3174.2
9 KHARKOF ARS-NRPN-2005-AMES_KHARKOF_15002 2 1 15002 772.065 3241.45
10 MACE ARS-NRPN-2005-AMES_MACE_15016 2 1 15016 753.36 4909.25
11 N02Y5075 ARS-NRPN-2005-AMES_N02Y5075_15010 2 1 15010 774 5329.5625
12 NO2Y5078 ARS-NRPN-2005-AMES_N02Y5078_15012 2 1 15012 777.87 4657.0625
13 N02Y5106 ARS-NRPN-2005-AMES_N02Y5106_15014 2 1 15014 760.455 4926.0625
14 NEO02513 ARS-NRPN-2005-AMES_NE02513_15024 2 1 15024 771.42 5198.425
15 NE02528 ARS-NRPN-2005-AMES_NE02528_15026 2 1 15026 775.935 5464.0625
16 NE02584 ARS-NRPN-2005-AMES_NE02584_15028 2 1 15028 795.285 5158.075
17 NE02592 ARS-NRPN-2005-AMES_NE02592_15030 2 1 15030 761.1 5719.6125
18 NEKOTA ARS-NRPN-2005-AMES_NEKOTA_15008 2 1 15008 758.52 4408.2375
19 NH01036 ARS-NRPN-2005-AMES_NHO01036_15036 2 1 15036 750.78 5386.725

20 NH01048 ARS-NRPN-2005-AMES_NH01048 15038 2 1 15038 715.95 4724.3125
21 NI02425 ARS-NRPN-2005-AMES_NI02425_ 15040 2 1 15040 783.675 5867.5625
22 NI03427 ARS-NRPN-2005-AMES_NI03427_15032 2 1 15032 762.39 5564.9375
23 NP-02 ARS-NRPN-2005-AMES_NP-02_15018 2 1 15018 755.295 3917.3125
24 NUPLAINS ARS-NRPN-2005-AMES_NUPLAINS_15006 2 1 15006 783.03 4549.4625
25 OVERLAND ARS-NRPN-2005-AMES_OVERLAND_15034 2 1 15034 768.195 6402.2
26 SD00032 ARS-NRPN-2005-AMES_SD00032_15042 2 1 15042 768.195 3698.75
27 SD00258 ARS-NRPN-2005-AMES_SD00258_15044 2 1 15044 776.58 6187
28 SD01054 ARS-NRPN-2005-AMES_SD01054_15046 2 1 15046 766.26 5107.6375
29 SD01Wo064 ARS-NRPN-2005-AMES_SD01W064_15056 2 1 15056 772.065 4868.9
30 SD02024 ARS-NRPN-2005-AMES_SD02024 15048 2 1 15048 753.36 4492.3
31 SD02039 ARS-NRPN-2005-AMES_SD02039_15050 2 1 15050 781.74 4169.5
32 SD02480 ARS-NRPN-2005-AMES_SD02480_15052 2 1 15052 775.29 5309.3875
33 SD02771 ARS-NRPN-2005-AMES_SD02771_15054 2 1 15054 768.84 5131.175
34 SD02W129 ARS-NRPN-2005-AMES_SD02W129_15058 2 1 15058 755.295 4495.6625
35 SD98W175-1 ARS-NRPN-2005-AMES_SD98W175-1_15060 2 1 15060 788.19 5716.25
36 TX00V1117 ARS-NRPN-2005-AMES_TX00V1117_15020 2 1 15020 783.03 5494.325
37 98X0435-15 ARS-NRPN-2006-AMES_98X0435-15_11040 2 1 11040 788.19 6365.2125
Aa  AANMEL AT APC MPPAL ANNE AMEC AAMELAT 11090 e 1 11090 70N 10E 7740 A7AOOAANANA )
+ phenotype
Sheet1of1 | Selected: 1 row, 1,024 columns Default | English (USA) ‘ ='I‘ m | Average: 26053.732; Sum: 260537.32 +

@ MR @

100%




Advanced Search: Accessions

& https://wheat.triticeaetoolbox.org/search/stocks

84
3";‘;..? mTS/Wheat Manage  Analyze  Maps  About

Wizard

_> Accessionsand Plots  he New T3/Wheat

Progenies and Crosses

Select Field Trials iublic wheat data generated by the Wheat Coordinated Agricultural Project (Wheat CAP). Funding is provided by the S I t
66 A cce SSi ons Trai pod and Agriculture (NIFA) and the United States Department of Agriculture (USDA). The current project is funded through e e C
raits ) : A s
. Locations heat Yield Partnership (IWYP) and part of the Agriculture and Food Research Initiative (AFRI). « .
an d P I OtS ) it evolution of The Triticeae Toolbox (T3). We are in the process of transitioning all - Acce S S I O n S
from the Genotyping Protocols  to this new system. We encourage you to leave feedback about feature "X Leave Feedback
Genotyping Projects j tools, and/or any ideas you may have to improve the site.

Search menu Markers

Loci & Genes and PIOtS”

Genome features

Images f t h
People Explore T3 ro l I l e
Use the Search Wizard to explore the database using
T3 Phenotype Data Loaded various types of metadata. Q Open Search Wizard S e a rC h M e n u
March 13, 2019

Alternatively, you can search specifically for Accessions, Trials, Traits, Genoptyping
Projects, or Markers

Search Accessions
March 10, 2019

Information on data loaded from T3.

News Item Title [ Search Trials ] [ Search Traits ]

Search Markers

Put news item content here.

[ Search Genotyping Projects ]
It can contain any HTML.

News Item Title
March 10, 2019

Put news item content here.

It can contain any HTML.

Put news item content here.

1t 4ai LITAAL

Submit Data

Contributing data to T3?




Advanced Search: Accessions
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Search Accessions and Plots

) Search

Search by Genetic Character:

Stock Name or

D » Select “Advanced Search”

- then “Genotypes”
Select Locus:

Search By Locus Allele _—
Value: v 1RS:AL :m
1RS:1BL r

= « Select a Locus (Genetic

Ax1 or null allele
Ax2* allele
Bdv2/3

i p— Select one or more C h a ra Cte r)

Genetic Characters / Loci

of interest
Fhb_1A_Neuse
Fhb_1B_Jamestown
Fhb_2B_Bess
Fhb_2DL_Wuhan/W14

e BRI « Select an Allele value

. Fhb_6A_Jamestown
Show| 10 7 entries Fhb_BA_Neuse

Fhb_Massey_3BL

Search Results

Stock Name Stock Type Org Glu 2+12 allele ms Owners Organization
Glu 5+10 allele

0050249-9 accession Triti Glu-B3c Clay Birkett AgriPro-Syngenta
Growth habit

00B553 accession Triti H13 Clay Birkett Cornell University
H9

00S0224-23 accession Triti Hardness Clay Birkett AgriPro-Syngenta
Height

00S0211-29-4 accession Triti HGPC/Yr36 Clay Birkett Cornell University
Lr19/Sr25

00S0240-3 accession Trith 21 Clay Birkett AgriPro-Syngenta
Lr34/Yr18/Pm38

00S0291-3 accession Triti Lr37/Yr17/Sr38 Clay Birkett Cornell University
Lrd2

00S0063-1 accession Triti Lr67 Clay Birkett AgriPro-Syngenta
Lr68

001169-7E15 accession Triti Lr9 Clay Birkett Cornell University
PHS 3AS

00S0251-6 accession Triti Pina-D1a Clay Birkett AgriPro-Syngenta

v

Li0axa2 i S Dinl L




Advanced Search: Accessions

m T3/Wheat  Search Manage  Analyze  Maps  About (oWl testing = Lists Calendar i@ 3

(~) Genotypes

e T Search by Genetic Character:

Select Allele Value:

et R x| _
 The results table contains

Accessions that match all
search criteria

(~) Search Results

View Another Property: variety . m
Show| 10 #|entries [ R I t b d t
Stock Name Stock Type Organism Synonyms Owners Organization e S u S Ca n e S a Ve O a

L]
' AR06024-7-2 accession Triticum aestivum Clay Birkett University of Arkansas I I St

Results are Accessions

GA04496-S5 accession Triticum aestivum Clay Birkett University of Georgia
that are characterized
. R GAD4496-S8 accession Triticum aestivum Clay Birkett University of Georgia
as ‘Present’ for Fhb1
ARGEQ7-1354-2-6- accession Triticum aestivum Clay Birkett University of Arkansas
1
ARGE08-1398 accession Triticum aestivum Clay Birkett University of Arkansas
GAMDO08-27-E9- accession Triticum aestivum Clay Birkett University of Georgia
S13
GAD4496-56 accession Triticum aestivum Clay Birkett University of Georgia
15NORD-25 accession Triticum aestivum Clay Birkett USDA-ARS
16NORD-62 accession Triticum aestivum Clay Birkett USDA-ARS
16NORD-54 accession Triticum aestivum Clay Birkett USDA-ARS

Showing 1 to 10 of 56 entries Previous 1 2 3 4 5 6 Next




Advanced Search: Accessions
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Organism Triticum aestivum

Stock type accession S h b G t n C h t -
Uniguename AR06024-7-2 e a rc y e n e I c a ra c e r ]
Description CB stock 221085 (AR06024-7-2)

* The Accession detail page
o includes a table of all
associated Loci that have been

characterized for the Accession

Synonyms

Additional information

institute code UAR

institute name University of Arkansas

notes In TCAP project 14_TCAP_ABB_SRW_STH

PUI http://triticumbase.sgn.cornell.edu/stock/221085/view
organization University of Arkansas

pedigree AR800-1-3-1/VAO1W-476

Associated loci

Locus name Allele name Phenotype
Al characterized P sua Absent
genetic characters St ot
for thIS SpeCifiC Ax1 or null allele Absent
ACCQSSiOn Ax2* allele Present
Bdv2/3 Absent
Bx7 over-expressing Absent
Color Red
Fhbl Present
Glu 2+12 allele Present
Glu 5+10 allele Absent
Growth habit Winter
H13 Absent

H9 Absent




Advanced Search: Accessions
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Search

[ e e Search by Pedigree:

Search Accessions and Plots
(=) Search
(~) Name Search

:  Select “Advanced Search” then

contains % | Type search here

= E= “Properties”

Description:

“

Organism: A Stock

P e * Next to “Search By Another
Property” select “pedigree”

Organization: 1. 1, Autocomplete

v variety
donor
donor institute
donor PUI
N country of origin
() Usage | state
institute code
institute name
biological status of accession code
notes
accession number
PUI
seed source
type of germplasm storage code

Se IeCt the acquisition date
‘pedigree’ organization

location_code
prope rty ploidy_level
genome_structure
ncbi_taxonomy_id
(~) Search Results transgenic
| introgression_parent

View Another Property: introgression_backcross_parent I

(%) Phenotypes

(+) Genotypes

introgression_map_version

introgression_chromosome

introgression_start_position_bp
Show | 10 % entries introgression_end_position_bp

Stock Name Stock Type Organism ~ Synonyms Owners Organization




Advanced Search: Accessions
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() T3/Wheat

Search Manage Analyze

(-) Search
() Name Search

Stock Name or
Description:

() Advanced Search
(-) Properties

Organism:

Organization:

Search By
Another
Property:

pedigree:
() Usage
(+) Phenotypes

(+) Genotypes

Maps About

(oWl dwarings7 | Lists[El CalendariE [c3

Search

Wizard | Acoseslons nd plots [ Marers | imeges | People

Search Accessions and Plots

contains

Stock
Type:

% | Type search here...

accession

Stock

Type to Autocomplete
Owner:

Type to Autocomplete

pedigree

contains

m Add the property to
the search criteria
¥+ JERRY n
\ Type the name of the

Accession that you want
in the pedigree string

Search by Pedigree:

 Select “Advanced Search”
then “Properties”

* Next to “Search By Another
Property” select “pedigree”



Advanced Search: Accessions

() Search Results

View Another Property: pedigree : Sea rc h by Ped i g ree :

Show| 10 % |entries

Stock Stock

Name  Type Organism Synonyms Owners organization pedigree The reSUItS table Wi” Only inCIUde
oS accssson T e EET e Accessions that have JERRY In

CA9WO7- accession Triticum Transfer USDA-ARS Falcon/Jerry

[ ] L ]
their Purdy pedigree
CA9WO0B- accession Triticum Transfer USDA-ARS Jerry/CDC Falcon
856 aestivum From T3
NDSU-11 accession Triticum Transfer North Dakota 11M225-123-2 = RWG10

aestivum From T3  State University (FHB1)/JERRY
15NORD- accession Triticum Transfer USDA-ARS CMB2036/Jerry
25 aestivum From T3
CA9WO07- accession Triticum Transfer USDA-ARS Jerry/Falcon
818 aestivum From T3
NDSU-10 accession Triticum Transfer North Dakota 11M225-123-1 = RWG10
aestivum From T3  State University (FHB1)/JERRY
CA9WO07- accession Triticum Transfer USDA-ARS Jerry/Falcon
819 aestivum From T3
16NORD- accession Triticum Transfer USDA-ARS SDO7W083-4/Jerry
58 aestivum From T3
15NORD- accession Triticum Transfer USDA-ARS RWG10/Jerry
32 aestivum From T3

Showing 1 to 10 of 19 entries Previous 1 2 Next




 Lists are used throughout various parts of Breedbase:
- List of Accessions are required for creating a trial

- List of Traits are required for creating a phenotyping spreadsheet

- Lists can be used in the Search Wizard

 Lists can be generated in many ways:
- From the Search Wizard

- From a Search Result table

- Manually through the List Manager

» Lists can be made public and shared



Using Lists

j ::: m T3/Wheat Search  Manage  Analyze

Add 1 or more
filtering criteria

Locations :

Search

select Al [[ZZ3] ciear
Aberdeen, ID
Akron, CO
Alliance, NE
Altus, OK
Archer, WY
Ames, 1A

Match JEUAE ALL

Create Ne Create

Load Dataset

Create New Dataset

Load/Create Datasets using Matcn Columns

Maps About

(oWl dwarings7 | ListsEl Calendar@ [cd

Search Wizard

Don't see your data? Refresh Lists Update Wizard

a“@

Trials Select Column Type & Select Column Type

Search Search Search

Select Al m Clear Select All m Clear

Select All [ulval/l Clear

ARS-NRPN-1998-A
ARS-NRPN-1999-A
ARS-NRPN-2000-A

ARS-NRPN-2001-A
B \cc vioon annn A

veen el AL Select the items you’re interested in

Add to Li ¢ m <4— Add to an existing List
OR

| hmes Tric | <4 Create a new List
Related Genotype Data

Related Trial Metadata

Related Trial Phenotypes

Create a List -
Search Wizard:

Lists can be created
directly from the
Search Wizard

Any selected items of
any data type can be
added to an existing or
new List



Using Lists

,", mTS/Wheat Search  Manage  Analyze  Maps  About Q

e Create a List -
Search Results:

Trial Search

Show | 10 3 entries Search: |/Ames

A Breeding Planting Harvest
Trial name Description program Folder Year Location Trial type Design Date Date Download

[ ]
ARS-NRPN-1998-AMES Northern Regional USDA-ARS 1998 Ames, IA phenotyping_trial CRD Download Plot Layout L I StS Ca l l b e Cre ate d

Performance Nursery,
USDA-ARS Hard
Winter Wheat Regional

Nursery Program Trials

- Northern Regional

Performance Nursery,

Lat and Lon positions
are for nearby town

das Search resulits
planting date

unknown. Actual

harvest date unknown.

ARS-NRPN-1999-AMES Northern Regional USDA-ARS 1999 Ames, IA  phenotyping_trial CRD
Performance Nursery,
USDA-ARS Hard
Winter Wheat Regional

Nursery Program Trials “

- Northern Regional O O O r e O
Performance Nursery,

Lat and Lon positions

are for nearby town

Results to a List”

harvest date unknown.

[}
Showing 1 to 10 of 10 entries (filtered from 2,434 total entries) Previous 1 Next S e Ctl O | I

Download Plot Layout

Copy Results to a List Copy the trial names currently showing in the search results table to a new or exisiting list

NOTE: Only the visible
= items will be added to the

list (ie, items on other
pages will NOT be added)




Using Lists

= — [ ]
I @DToWnear sean wansge Anayie Maps Avou a - | Manage Your Lists:

Welcome to the New T3/Wheat

L]
T3 is a repository for public wheat data generated by the Wheat Coordinated Agricultural Project (Wheat CAP). Funding is provided L I Sts Ca n b e C re ate d

by the National Institute for Food and Agriculture (NIFA) and the United States Department of Agriculture (USDA). The current
project is funded through NIFA's International Wheat Yield Partnership (IWYP) and part of the Agriculture and Food Research

L
e A manually, by entering
)
The New T3 is the next evolution of The Triticeae Toolbox (73). We are in the process of -
transitioning all of T3's data and tools to this new system. We encourage you to leave X Leave Feedback .
feedback about feature improvements, missing tools, and/or any ideas you may have to e n a I I I eS O e I e l I I S

improve the site.

News Explore T3

To manage your Lists,
TomenetpenLosded  aroue g oot [ i click the “Lists™ button

Alternatively, you can search specifically for Accessions, Trials, Traits, Genoptyping
Projects, or Markers .
from the top right
Analyze, Selection Index
The Selection Index determines [ Search Genotyping Projects ] [ Search Markers ‘ CO rn e r Of a n y pag e .

rankings of accessions based on
more than one trait

2456 Phenotype trials and mean
data loaded from T3.

[ Search Accessions ] [ Search Trials ] [ Search Traits ]




Using Lists

Your Lists

Create New List: Create New List. Type New List Name Here

Add a List name —v
and (Optlonally) a Description For New List
description /

Show | 10 % entries

List Name 4 Description
5ST ADV 2001

Ames Trials

Checks

Example Traits
Infinium_90K_Lines
Lines with NING7840
NRPN Ames 2005-2007
SD Winter Wheat
Single Trial Test

UIL 2018

Type
trials
trials
accessions
traits
accessions
accessions
trials
accessions
trials

trials

Validate

AL N N N N N N W NN

=
o
H

X X %X X X X X X X %

L

Search:

Download

* € e e e

Share

¥ ¥ ¥ ¥ ¥ O ¥ ¥ O

[\

smTu 1 to 10 of 10 entries

Click the List name to modify its contents

Previous 1 Next

View Public Lists Close

Create a List —
Manually:

Enter the List name
and description
(optional)

Click the “New List”
button to create the
List

Click the List Name to
edit the List contents



Using Lists

Modify a List (Add Items):

List ID 188

List name:

2020 Checks

Select the List type

Description: . .
Checks used in the 2020 Trials

Type:

Enter the names of the list items

_ (one item per line)
- The names must match
existing items in the

database

Sort Ascending 12 Sort Descending 1

o Click the “Add” button to add the
items to the List




Using Lists

n] & wheat.triticeaetoolbox.org 9] =

u u
[ ]
C 1l Weath DW F Other Bookmark:
© @8 Comell @B Westher - i wheat.triticeaetoolbox.org says » | @ Other Bookmarks Val Idate th e LISt L]

This list passed validation.

o Validating the List ensures all of the
List items are valid entries for the

Checks used in the 2020 Trials

cccccc : specified List Type

Click the “Validate” button under
the “Type” section

ERNE  Remove

eeeeee

Showing 1 to 3 of 3 entries



Using Lists

ﬂ{f:.;:‘ m T3/Wheat Search Manage  Analyze Maps  About Q (g L i st U sag e —
Search Wizard Search Wizard:

Don't see your data? Refresh Lists Update Wizard

2020 Checks Select Column Type v Select Column Type v L i Sts Ca n b e u S e d a S
selections in the
Select Al Clear Select Al Clear seiect All [ ciear select All [ clear sea rCh W|Za rd

5STADV_2001_Brownstc

ar
ar

Trials

List of 5STADV_2001_Columblz
Accessions 5STADV_2001_LoganCo
selected 5STADV_2001_Portagel
B ccrarv 9nns L dkana
& JERRY
ERNIE

BESS

Match ALL

Create New Li Create




Using Lists

Design New Trial

Intro Trial Information Design Information Trial Linkage Field Map Information Custom Plot Naming Review Designed Trial

@ © ®

Design your trial layout

Which accessions will be in the field? (—— List of Entries

List of accessions to include (required): SD Winter Wheat )
List of checks to include. Checks list should be separate from accessions list. Checks )
(optional):
Need to create a list of accessions?  wmanage Uists List of Checks

Number of blocks (required):
Continue to Next Step

Close

List Usage —
Trial Design:

Lists of Accessions
are used to specify
the entries and
checks used in a
phenotyping Trial



« A Trial must be created before any phenotyping data can be added

« ATrial contains metadata about itself:
- Trial Name (must be unique)
- Breeding Program (must already exist)
- Location (must already exist)
- Trial Type (phenotyping, greenhouse, Preliminary Yield Trial, Advanced...)
- Year
- Plot Dimensions
- Field Size
- Description
- Design Type (Randomized, RCBD, Incomplete Block, Augmented, ...)




« A Trial contains information about the physical plot layout

e Each plot has information about itself:
- Block
- Rep
- Row & Column
- Accession
- Observations

* The plots can be created:
- Using the Trial Design wizard
- Uploading a plot layout template



Before you design a new Trial, make sure you have the following:

* Breeding Program
- Each Trial is associated with a single Breeding Program
- If your Breeding Program doesn’t exist it will have to be added first
* Location
- Each Trial is assigned to a single location
- Each Location is associated with one or more Breeding Programs
- The Location of your Trial needs to exist AND be associated with your
Breeding Program
 Lists of Accessions for entries (required) and checks (optional)



Trial Design

SANDBOX SITE - Data added to this site will be periodically cleared
- | u
e T3/Wheat  Search Analyze  Maps  About (oWl dwaring87 | Lists Calendari@ [ M F I d T I .
9 T anage Field Trials:

Breeding Programs

Locations
Welcome to the | Accessions ndbox
Select Crosses “ I ”
| ) ou elect "Field Trials
ke F |€| d W‘? Field Trials can be used to test the addition of new data to T3. Data added to this site will be
. ., periodically cleared and Phenotyping Results at site. Once your data is ready, please go to the main T3/Wheat site to permanently
Trials”  submi your data Genotyping Piates from the Manage
Trait Ontology Browser
T3 is a repository for public Compose a New Trait {Wheat Coordinated Agricultural Project (Wheat CAP). Funding is provided by the l I l e n u
National Institute for Food ¢ United States Department of Agriculture (USDA). The current project is funded
through NIFA's Internationa Download YP) and part of the Agriculture and Food Research Initiative (AFRI).
Upload
The New T3 is the next evg B'grcodes ox (T3). We are in the process of transitioning all -
of T3's data and tools to thi i you to leave feedback about feature X Leave Feedback
improvements, missing too User Roles have to improve the site.
News Explore T3

Use the Search Wizard to explore the database using
T3 Phenotype Data Loaded various types of metadata. Q Open Search Wizard

March 13, 2019
Information on data loaded from T3. Anernatlvely. you can search specifically for Accessions, Trials, Traits, Genoptyping
Projects, or Markers

News [tem Title [ Search Accessions ] Search Trials Search Traits

March 10, 2019

Put news item content here. [ Search Genotyping Projects ] Search Markers
It can contain any HTML.

News [tem Title
March 10, 2019

Put news item content here. Submit Data




Trial Design

SANDBOX SITE - Data added to this site will be periodically cleared

a4 »
‘{y" S m
1AW

T3/Wheat  Search  Manage  Analyze
SANDBOX

(=) Trials

Information

Search

Search

Download Trial Phenotypes

Select multiple trials by holding 'Ctri".
Download Phenotypes

Double click
trial (@ ) or folder (&)
to view detall page.

Breeding programs (= )

Folders

Create new folder
Move trial(s) to folder

Move folder

Maps

About

Manage Trials

Add a Trial by uploading

a plot layout template

& https://wheat.triticeaetoolbox.org/breeders/trials

(oWl dwaring87 | Lists[El | Calendar @

‘ Upload Existing Trial || Design New Trial ’

Breeding Programs -- Folders -- Trials Refresh

=
=
=
=

5

i
#a |(ansas State University - Hays

Agri-Food Alberta
Agri-Food Canada
Agri-Food Manitoba
Agri-Food Saskatch
AgriPro-Syngenta

Cereal Research Inst

CIMMYT

Clemson

Colorado State Univ
Colorado State University
Cornell University

Dow AgroSciences
EVIGEZ Czech Republic
Genesis Seeds

Gortzen

Kansas State University

s LA\NIC

®= Agriculture and Agri-Food Canada
— #a Agriculture and Agri-Food Canada Alberta

— #a Agriculture and Agri-Food Canada Manitoba

— == Agriculture and Agri-Food Canada Saskatchewan Ad d a Tn al by

creating the

plot layout
using the Trial
Design Wizard

[} # Cereal Research Institute Non-Profit Ltd.

(]

Create a Trial:

* Upload Existing Trial
- You create and upload a
template defining the plot
layout

* Design New Trial
- The Trial Design Wizard
defines the plot layout



Trial

Breeding Program:

Locations: (One or More)

Trial Name:

Trial Type:
Year:

Plot Width (m):
Plot Length (m):
Field Size (ha):

Description:

Design Type:

Design

Design New Trial

Design Information Trial Linkage Field Map Information Custom Plot Naming Review Designed Trial

Enter basic information about the trial

Cornell University

Helfer, NY
Ithaca, NY
Ketola, NY
McGowan, NY

Locations Selected: 1

TEST_TRIAL

Location abbreviation will automatically be added as a prefix if multiple locations are selected.

phenotyping_trial

2019

1

1

This is a test Trial

Complete Block

generates Randomized Complete Block Design, using the methods of random number generation

in R. Creates plot entities in the database.

T e
‘ First validate the form () Continue to Next Step '

Design New Trial:

Click the “Design New Trial” button from the

Manage Trials page

Fill out the basic information about the Trial:
location, plot dimensions, design type, etc...

Validate the form

Continue




Trial Design

Design New Trial

Trial Information Design Information Trial Linkage Field Map Information Custem Plot Naming Review Designed Trial

1 O ®

Design your trial layout

Which accessions will be in the field? / List of entries

List of accessions to include (required): SD Winter Wheat Accessions P9

List of checks to include. Checks list should be separate from accessions list. Checks

(optional): v
W List of checks

Need to create a list of accessions? Manage Lists

Number of blocks (required): 3 \
Continue to Next Step

Y

o

Number of Blocks

Design New Trial:

Select the Lists of
entries and checks

Enter the number of
blocks

Continue




Trial Design

Design New Trial

Trial Information Design Infermation Trial Linkage Field Map Information Custom Plot Naming Review Designed Trial

© © o o ©® L©

Specify the number of rows and columns for the entire field

By default field map display is set to serpentine and uses the block or rep number as row number.

If you do not want to create field map along with this trial, set 'Plot layout format' to 'select plot layout format'.

If you do not know exactly in which rows and columns you will end up planting the plots, do not provide this and go to the next step.
If you will plant your plots in an irregular (non-rectangular) layout, do not provide this and go to the next step.

You can upload the exact row and column information for your plots (in any layout shape) on the Trial Detail Page after you have created the
trial in the database and actually planted the experiment.

Enter number of Rows

Field map display:

Number of rows (optional): 6

Plot layout format: Serpentine

‘\ Select how plots
Continue to Next Step are ordered

Design New Trial:

Enter the number of rows
(needs to be a number
that gives rows with an
equal number of plots)

Choose plot layout format
Serpentine:

1 2 3

6 5 4
7 8 9

ZigZag:

1 2 3
4 5 6
7 8 9



Trial Design

Design New Trial

] n
esign New Irial.
Trial Information Design Information Trial Linkage Field Map Information Custom Plot Naming Review Designed Trial u

0)

Review the generated trial layout. Make sure to click Submit at the bottom of this page if you approve of the triall

L]
Check to confirm that your design looks good. If there are any problems you can redo the randomization step. E a CI I b I O C k I S a re p

Even Block Numbers (e.g. 2,4,...) MOdd Block Numbers (e.g. 1,3,...) B Checks ™= Odd Rep Numbers (e.g. 1,3,...)
™= Even Rep Numbers (e.g. 2,4....)

Randomly assigns entries to plots within
each block / rep

Dark blue plots are checks

Plot Name Accession Plot Row Col Block Block Block Rep Seedlot Num
Name Number number number Number Row Col Number Name Seeds

Number Number Per

Plot

TEST_TRIAL-repl- SD12DHA01373
SD12DHA01373_1

TEST_TRIAL-repl- SD10066
SD10066_2

TEST_TRIAL-repl- SD10135
SD10135_3

TEST_TRIAL-repl- SD12DHA03614
SD12DHA03614_4

TEST_TRIAL-repl- SD12DHA01556
SD12DHAD1556 5




Trial Design

— Design New Trial:

v
Trial Is Valid
The following trial will be added

Desian ype « Redo Randomization:

Randomized Complete Block Design

- Will reshuffle the plot

Number of accessions

. assignments with the same

Number of checks

2 parameters

Number of blocks
3

Number of accessions per block
Block 1: 36 accessions

Do 30 sccessone e Confirm
- Will save the Trial to the

Treatments:
database

Close




Trial Design

SANDBOX SITE -

added to this site will be periodically cleared

:‘"‘ (™ T3/Wheat  Search  Manage Anayze Maps  About S| dwaring87 Calendar |4
SANDBOX

Trial detail for TEST_TRIAL

] ]
@ Trial Details View and edit basic information about the experiment. D e s I g n N ew I rl a I "
n
Edit Trial Detalls

e Lt i An empty trial now exists

Fy

Trial Location Ithaca, NY
iy
Year 2019
Trial Type phenotyping_trial TEST_TRIAL SGN6182 T L] I D t [ I I I lfl I
Planting Date [No Planting Date] rI a e a I S Ca n e | I I O I I e
Harvest Date [No Harvest Date] Plot Width 1
(m)
Description This is a test Trial
Plot Length 1
Folder Cornell University (m)
] [ oL
Field Size [No
New Folder Change Folder (ha) Field
Size)

Trial Will Be no
Genotyped

Trial Will Be no
In Crosses

Phenotype observations can be
added

\J
, Directly record phenotypes ﬂ

to database for this trial.

E-E Generate barcode labels for m

plots or plants or
accessions in this trial.

Field Layout View and edit the spatial layout of the experiment. Also view a heatmap for phenotyped traits.
Tools and
Phenotype
Heatmap




Once the Trial has been added to the database:
« A“phenotyping spreadsheet” can be created for the trial
- Specific to an individual trial
- Contains a column for each selected trait

* Observations are added to the phenotyping spreadsheet

* The phenotyping spreadsheet is uploaded for the trial



Open the Trial Detail page:

« Search > Field Trials
- Filter by name in the Search box
- Click Trial name

 Manage > Field Trials
- Expand Breeding Program
- Double click Trial name

« Search > Wizard
- Include any filters before Trials
- Filter by Trial
- Click Trial name



Phenotype Upload

P Compute New Phenotypes Compute derived traits or

h Upload Data Files Phenotypic data collection using Excel or Android Fieldbook. Also upload any additional files for this trial.

*

Data Collection Files

Phenotyping Spreadsheets

Android Field Book Layout

Data Collector
Spreadsheet

Upload Phenotyping Files

Ph typing Spreadsheet:

Android Field Book Exported

Data Collector Spreadsheet

Uploaded Phenotyping Files

Filename Date Uploaded Uploaded By

compute plot phenotypes from plant phenotypes.

Create Spreadsheet

Create Field Book

Create DataCollector Spreadsheet

Upload

Upload

Upload

Phenotypes Fully Uploaded?

File Type Options

Create Phenotyping Spreadsheet:
From the Trial Detail page:

* Find the “Upload Data Files”

section

Find the “Data Collection
Files” subsection

Next to “Phenotyping
Spreadsheets” click the
“Create Spreadsheet” button



Phenotype Upload

Download Phenotype Spreadsheet for TEST_TRIAL C reate P h e n Otyp i n g S preads h eet :

Trial: TEST_TRIAL

Trait List: Example Traits LISt Of Tr’ﬂtS observed . SeIeCt the IiSt Of Traits that Wi” be
S in this Trial observed in this Trial

Include Notes Column

Spreadsheet Format: Detailed

. B Optionally include a column for plot-
level notes

Spreadsheet Format:

« Simple: includes a plot name
column and a column for each
trait

* Detailed: includes more trial
and plot-level information



Phenotype Upload

Populate Phenotyping Spreadsheet: Simple Format

A B C D

observationunit_name Grain test weight g/I|CO_321:0001210  Grain yield kg/ha|CO_321:0001218 notes
TEST_TRIAL-rep1-SD12DHA01373_1
TEST_TRIAL-rep1-SD10066_2
TEST_TRIAL-rep1-SD10135_3
TEST_TRIAL-rep1-SD12DHA03614_4
TEST_TRIAL-rep1-SD12DHA01556_5
TEST_TRIAL-rep1-SD12DHA01364_6
TEST_TRIAL-rep1-SD13052-1_7
TEST_TRIAL-rep1-SD110060-7_8

10 TEST_TRIAL-rep1-SD12DHAD01328_9
11 TEST_TRIAL-rep1-SD110038-3_10

12 TEST_TRIAL-rep1-S9212DHA01024_11
13 TEST_TRIAL-rep1-5,13062-2_12

oo~ s wWwN =

14 TEST_TRIAL-rep1-S2110044-7_13 Enter Enter
15 TEST_TRIAL-rep1-S/)12008-2_14 . . .
16 TEST TRIAL-rep1-SD10257-2 15 test weight grainyield

17 TEOT TRIAD cawmd ANNDOCc 4 Ao

18| Plot name: includes
20 [trial name, rep number,
21| accession name and

23 plot number
24 TEST TRIAL-rep1-SD13090-7 23

here here



Phenotype Upload

Populate Phenotyping Spreadsheet: Detailed Format

Spreadsheet ID
Trial name(s)
Description(s)

|Tria| location(s)

Predefined Columns

plot_name
TEST_TRIAL-rep1-SD12DHA01373_1
TEST_TRIAL-rep1-SD10066_2
TEST_TRIAL-rep1-SD10135_3
TEST_TRIAL-rep1-SD12DHA03614_4
TEST_TRIAL-rep1-SD12DHA01556_5
TEST_TRIAL-rep1-SD12DHA01364_6
TEST_TRIAL-rep1-SD13052-1_7
TEST_TRIAL-rep1-SD110060-7_8
TEST_TRIAL-rep1-SD12DHA01328_9
TEST_TRIAL-rep1-SD110038-3_10
TEST_TRIAL-rep1-SD12DHA01024_11
TEST_TRIAL-rep1-SD13062-2_12
TEST_TRIAL-rep1-SD110044-7_13
TEST_TRIAL-rep1-SD12008-2_14
TEST_TRIAL-rep1-SD10257-2_15
TEST_TRIAL-rep1-SD110085-1_16
TEST_TRIAL-rep1-SD13099-8_17
TEST_TRIAL-rep1-SD12DHA01131_18
TEST_TRIAL-rep1-ERNIE_19
TEST_TRIAL-rep1-SD12DHA00324_20
TEST_TRIAL-rep1-SD12DHA01353_21
TEST_TRIAL-rep1-SD12DHA01038_22
TEST_TRIAL-rep1-SD13090-7_23

B o

ID3081575492609  Spreadsheet fo BasicExcel

Enter operator here
Enter date here
TEST_TRIAL: Ithaca, Design Type(siTEST_TRIAI_l: RCBD

TEST_TRIAL Operator
TEST_TRIAL: This is Date

a

accession_name plot_number
SD12DHAD1373 1
SD10066 2
SD10135 3
SD12DHAD3614 4
SD12DHAD1556 5
SD12DHA 1364 6
SD13052- 7
SD11006C 7 8
SD12DHA 11328 9
SD110038-3 10
€

<Accession Plot

¢ Name Number
SD10257-2 15
SD110085-1 16
SD13099-8 17
SD12DHA01131 18
ERNIE 19
SD12DHA00324 20
SD12DHAD1353 21
SD12DHAD1038 22
SD13090-7 23

D

block_numbeis_a_contrcrep_numbe planting_date harvest_date

1

N PR Ny K N N N [ N N N [ N U\ U N U N U N U ) [ W) I N U\ P N QU N K N U W UK N )

JEE N PR N K N N N [N N N W [ N K N U N U N N W) N N P W U N U\ [N N U W UK N U W UK N UK g U N N

trial_name

TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL
TEST_TRIAL

Grain test weight g/l|C Grain yield kg/ha|Cnotes

Enter Enter
test weight | grain yield

here here



Phenotype Upload

n
Upload Phenotypic data collection using Excel or Android Fieldbook. Also upload any additional files for this trial. U pl d P h typ g S p d h t-
lfh oa enotypin readsheet:

From the Trial Detail page:

Phenotyping Spreadsheets Create Spreadsheet

Android Field Book Layout Create Field Book o F i nd the I U pIOad Data F i I es,,

Data Collecto
r Create DataCollector Spreadsheet

Spreadsheet S e Cti On

* Find the “Data Collection Files”
Phenotyping Spreadsheets Upload S u b S e Cti O n

Android Field Book Exported Upload

Data Collector Spreadsheet Upload

* Next to “Phenotyping
Spreadsheets” click the
“Upload” button



Phenotype Upload

Upload Phenotype Spreadsheet

Select
Spreadsheet

File format information
Spreadsheet Format ( Format

Spreadsheet Detailed
Format:

Timestamps
Included:

A~
v

Data Level: Plots

Choose File  downloadjuvob.xls Select your

Spreadsheet: phenotyp I ng
spreadsheet

Phenotype

Upload Phenotyping Spreadsheet:

Select the format of the phenotyping
spreadsheet

Choose your phenotyping
spreadsheet

Verity the file

Store the observations



Phenotype Upload

Phenotype Summary Statistics

Download Trial Data

View and download uploaded phenotype data.

After Upload:

Raw Data Statistics

' Phenotype summary available on the Trial
Show [ 10 | entries search: [ .
et e e S o T, Detail P age

g/1|C0_321:0001210

Grain yield 3300.12  3296.22 3304.22 1.82 0.06% 108 0%
kg/ha|CO_321:0001218

e Includes mean, ranges, histograms of each
| trait

Select: Grain test weight g/|CO_321:0001210 s Definition

Display: Values for Plots in this Trial N




Phenotype Upload

& https://wheat.triticeaetoolbox.org/help/phenotype upload_ workflow
m () T3/Wheat  Search  Manage  Analyze  Maps  About Q S

Phenotype Upload Instructions

| |
These nsirotions il qude you through the process of creating a phenotype il and uploading the resuls of U p | o) ad Wo rkf | oW an d | nstructions:

the trial to T3. In order to submit data, you must first Create an Account and Login.

If you have any questions about the process, please feel free to Contact Us.

Breeding Program

L]
All data (such as Accessions and Trials) are associated with a particular Breeding Program. Generally, we have a Breeding G e n e ra I Ste p S fo r u p I O a d I n g d ata fo r a
Program for each University / Institution that submits data to the database.
1. Make sure your Breeding Program exists in the Database . :
o View existing Breeding Programs: Manage > Breeding Programs p e n O y p I n g rI a
2. If itis not listed, add it to the Database (by using the Add New Program button at the bottom of the page)
© View the Managing Breeding Programs manual page for more information.

Check prerequisites

A phenotyping trial must be linked to a specific location. Generally, the location of a trial is set as the closest town to the
actual field site.

1. Make sure the Location of your Trial(s) exist in the Databse
o Use the Manage > Locations page to search for existing Locations.

[
2. If the one or more of your Locations don't exist in the database, you can add them by: C re a te th e I rI a I

o Finding the location on the Map, clicking, and filling out the location details form.
o Uploading a File of location information.
© View the Managing Locations manual page for more information.

L]
3. Make sure your Breeding Program is associated with the location. C t th h t d h t
o In the Location Table on the Manage > Locations page, the Program column lists all of the Breeding re a e e p e n O y p I n g S p re a S e e
Programs associated with each Location.
o If your Breeding Program is NOT associated with the Location:
1. Find the location on the map
2. Click the Edit link ]
3. In the Program select box, ctrl-click / command-click your Breeding Program from the list to add it U I O a d th e h e n Ot I n S re a d S h e et
to the existing Breeding Programs already associated with the location.

4. Click the Store Location Details button to save your changes.

Accessions

Each Accession / line that is observed in a phenotype trial must have its own entry in the database. In addition, the names
used in your trial design must match the names of the Accessions in the database.




Trial Summary Tool

& https://wheat.triticeaetoolbox.org/tools/trial/summary/list

84 -
«Xf’:{i\ mTS/WheaT Search  Manage

Maps  About

Breeder Tools
Breeder Home

Welcome 10 selection Index pat
Select Genomic Selection

“Summarize T3 is a repository for éccassmn Usage  ieq by the Wheat Coordinated Agricultural Project (Wheat CAP). Funding is provided

Trials” from by the National Insi Somparg Tng_sl ure (NIFA) and the United States Department of Agriculture (USDA). The current project 13 - - 7
is funded through * ummarize Tals — yielq partnership (IWYP) and part of the Agriculture and Food Research Initiative e e C u ' ' l ' l l a rl Z e rl a S ro ' I l
(AFRI).

the An a I yze ) Sequence Analysis
The New T3 is the ni leae Toolbox (T3). We are in the process of

enu BLAST

transitioning all of T3 lew system. We encourage you to leave X Leave Feedback

feedback about feature improvements, missing tools, and/or any ideas you may have to
improve the site.

the “Analyze” Menu

News Explore T3

Use the Search Wizard to explore the database

T3 Phenotype Data Loaded
Nov 28, 2019

2456 Phenotype trials and mean
data loaded from T3.

Analyze, Selection Index

The Selection Index determines
rankings of accessions based on
more than one trait

Analyze, Summarize Trials
Summarize Trials shows Least
squares mean values in selected
Trials

Search, Loci & Genes

Search Loci & Genes allows you to
search for genetic characters and
associated accessions

using various types of metadata. Q Open Search Wizard

Alternatively, you can search specifically for A
Projects, or Markers

Trials, Traits, ptypin:

[ Search Accessions ] { Search Trials ] [ Search Traits ]

[ Search Genotyping Projects } [ Search Markers }

Submit Data

Contributing data to T3?

Phenotype Upload Instructions: Instructions
and general steps for adding phenotype trial
data to T3.

A Upload Instructions

Manage your Phenotypic Data to create
spreadsheets for new uploads, add new data,
and/or manage your existing uploads.

/4 Manage Phenotypic Data

Or Upload Files for various other types of data.
typ % Upload Files

User Guides

New to T3?

© Read Documentation
View the Documentation to learn about

available features.




Trial Summary Tool

Select a
List
containing
2+ Trials

S

v
--------YOUR LISTS BELOW--------
5ST ADV 2001
ABB North Trials
NRPN Ames 2005-2007

Summarize trials

Choose a list of trials:

_1.. -r )

--=---=-PUBLIC LISTS BELOW--------
1998NRPN

5ST ADV 2001

UIL 2018

Note: Only traits that are observed across all Trials are available
to summarize.

Select a List that contains
2 or more Trials



Trial Summary Tool

Summarize trials

Choose a list of trials:

uiL 2018

Note: The list must contain at least 2 trials.

4k

Select traits to summarize:

Grain test weight g/1|CO_321:0001210
Grain yield kg/ha|CO_321:0001218

Plant height cm|CO_321:0001301

to summarize.

Summarize

Note: Only traits that are obsened across all Trials are available

Select the Traits
to summarize

Select 1 or more traits to summarize

Note: Only traits that have been
observed in all of the Trials will be
shown



Trial Summary Tool

Trial Summary

LS Means
Show | 10 #| entries Copy | CSV | Print search: [
Accession 4 Grain test weight g/1 Grain yield kg/ha Plant height cm
AGRIMAXX413 720.70 6115.20 83.26
LS Means for AGRIMAXX438 737.43 5737.25 87.49

each Trait AGRIMAXX444 726.93 6248.66 84.38 Tri a I S u m m a ry TOO I O Utp Ut :

across all Trials

AGRIMAXX446 728.00 6522.82 81.84

AGRIMAXX454 735.77 6321.07 86.08

AGRIMAXX463 723.49 5646.72 82.55 . .
A table with LS Means for each Trait
AGRIMAXX475 749.75 6084.53 80.86 .

across all Trials

AGRIMAXX485 747.48 5741.55 81.28

LSD 31.09 548.00 3.91

HSD 68.03 1199.03 8.56

Showing 1 to 10 of 88 entries Preious = 1 2 3 4 5 .. 9 Next Atable SummariZing eaCh Trait

Grain test weight g/l

Show | 10 5 |entries Copy CSV | Print Search:

UIL-WHEAT- UIL-WHEAT- UIL-WHEAT- UIL-WHEAT-
4 2018- 2018- 2018- UIL-WHEAT- UIL-WHEAT-  2018-
Accession BELLEVILLE ELKVILLE HAMPSHIRE 2018-NEOGA 2018-PERRY URBANA
AGRIMAXX413 - - 745.67 - 680.93 726.37
AGRIMAXX438 - - 749.54 - 720.83 732.80
Separate

summary table AGRIMAXX444 746.57 730.74 - 712.59 - -

fOr eaCh Tralt AGRIMAXX446 694.06 737.95 - 761.12 -
AGRIMAXX454 759.83 740.01 - 716.58 - --
AGRIMAXX463 694.70 734.60 767.56 727.78 702.81 713.49
AGRIMAXX473 732.42 701.14 770.13 737.18 721.73 737.18

AGRIMAXX475 774.76 723.15 740.53 779.27 728.17 752.62
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« Qrganizing Phenotyping Trials
- Within Breeding Programs
- Breeding Programs can contain folders for separate experiments

- Create Breeding Programs for Cooperative Nurseries?

« Adding Tools / Report Pages from T3/Classic
- Which ones are most useful?

- Genomic Selection tool?



Feedback

Get In Touch:

Email: diwb4@cornell.edu

Website: https://wheat.triticeaetoolbox.org/contact/form

What tools do you want to see in the New T3?

How can we make it easier to submit data?


mailto:djw64@cornell.edu
https://wheat.triticeaetoolbox.org/contact/form
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